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Motorized rotation mounts and stages are versatile instruments that introduce computer control to optical
systems, enabling automation and scanning actions. They can be used for intensity control and position
adjustments, etc. However, these rotation mounts come with a hefty price tag, and this limits their use.
This work shows how to build two different types of motorized rotation mounts for 1" optics, using
a 3D printer and off-the-shelf components. The first is intended for reflective elements, like mirrors
and gratings, and the second for transmissive elements, like polarizers and retarders. We evaluate and
compare their performance to commercial systems based on velocity, resolution, accuracy, backlash, and
axis wobble. Also, we investigate the angular stability using Allan variance analysis. The results show
that our mounts perform similar to systems costing more than €2000, while also being quick to build and
costing less than €200. As a proof of concept, we show how to control lasers used in an optical tweezers
and Raman spectroscopy setup. When used for this, the 3D printed motorized rotational mounts provide
intensity control with a resolution of 0.03 percentage points or better.
© 2021 Optical Society of America

1. INTRODUCTION

Rotation mounts and rotary stages are essential in many opti-
cal systems. They are versatile and can be used to adjust the
polarization direction in an attenuator setup, rotate the grating
in a spectrometer, or change the position of mirrors and filters,
among other things [1, 2]. Having these optical elements mo-
torized and controlled by a computer increases their usability
by allowing higher accuracy and repeatability, as well as the
possibility for automation and scanning actions. Unfortunately,
commercial rotation mounts and their corresponding drivers
come with a hefty price tag, discouraging their use.

On the contrary, 3D printers nowadays come with a fair price
tag thanks to the Do-It-Yourself community [3] and they have
gained significance in experimental research groups to develop
laboratory-specific equipment [4, 5]. This development has in
turn made key components of both 3D printers and rotation
mounts, like stepper motors and drivers, inexpensive and read-
ily available. Based on this, would it be possible to design rota-
tion mounts that combine the advantages of 3D printing with
the accessibility of its components? If so, how would its perfor-
mance and cost compare to similar systems made by industry-
leading manufacturers?

Previous papers addressing in-house rotation mounts [6, 7]

use fabrication techniques outside of the capabilities of the com-
mon lab. They developed rotation mounts that were either
unsuitable for standard optics or used components that are not
feasible to produce a low cost product. They also used a piezo-
electric rotor, which are known to cause vibrations, that can
disturb sensitive measurements. Therefore, in this work, we
design multipurpose rotation mounts for applications that uses
1" optics (1 in. = 2.54 cm). We build the mounts using a com-
mercial 3D printer [Ultimaker 2+], then we test and evaluate
their performance. We constraint the budget to €200 per mount
(incl. driver) and provide in-depth instructions and examples
for building and integrating them into an optical setup.

2. MATERIALS AND METHODS

A. 3D Printing Rotational Mounts

There are two main configurations of the rotation mount, the
reflective mount intended for reflective optical elements, and
the transmissive mount intended for transmissive optical ele-
ments. The reflective mount seen in figure 1a has its axis of
rotation along the optical element’s surface and is suitable for
applications involving mirrors and gratings. The transmissive
mount, seen in figure 1b, instead has its axis of rotation perpen-
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Fig. 1. The reflective mount (a) and transmissive mount (b) are
3D printed rotation mounts for different optical elements. Ar-
rows show the rotation (solid) and position adjustment (dashed)
for the mounts, which can be clamped to optical posts (omitted).

dicular to the surface of the optical element and is more suitable
for applications involving polarizers and retarders. Both setups
include a selection of holders for different optical elements and
applications, like filter revolvers and universal base plates. The
setups are made to be mounted on posts, where they can slide
and be clamped down in any (square) direction to fit most appli-
cations. We provide 3D files with mounts for both metric and
imperial post sizes, that is ∅12 mm or ∅0.5 in., as well as the
open-source 3D CAD model for further customization.

Components

We divide the components used for the rotation mount into
two categories, 3D printed parts and off-the-shelf components.
Parts that can be 3D-printed include a base mount (the frame)
and various rotor wheels used for different applications. They
are designed in Rhinoceros 3D [Rhino 6, Robert McNeel & Asso-
ciates] and the 3D CAD model (.3dm-file) can be found in the
resources [8, 9], along with exported .stl (stereolithography) and
.stp-files (AP 214, ISO 10303-21). These parts are designed to be
made with a fusion deposition modeling (FDM) printer, allowing
for rapid prototyping and in-house manufacturing.

Our mounts require a rigid and strong material to function
properly. Common plastics like polylactic acid (PLA), acrylonitrile
butadiene styrene (ABS) and polyethylene terephthalate (PET/PETG)
are all suitable alternatives, with the latter providing more dura-
bility [10]. We designed the mounts to print on almost any 3D
printer without using support material with a wide range of
parameter settings. We recommend a layer height of 0.4 mm and
nozzle size of 0.6 mm, or less. The infill can be as low as 20%, and
to increase the strength the number of perimeters (shells) should
be 3 or more. Further, which parts are needed depends on the
application. To help select what parts to print, we provide a
guide in table 2 in the appendix. In places where tight tolerances
are needed, like thru-holes for shafts and rods, finishing work
can be required. If a hole is too tight, it can be honed out with a
simple hand drill.

The off-the-shelf components also depend on the configura-
tion and, for this, part lists are provided in appendix A. Even
so, all rotation mounts use a standard NEMA 17 series step-
per motor. We have in this work used the cheapest and most
common one [17H2A4413, MotionKing], with a rotor resolu-
tion of 200 f ullsteps/revolution (1.8◦) and a holding torque of
40 N · cm, which is the recommended minimum. There is an
option to use factory-made aluminium pulleys for the trans-

missive mount, which is what we used in the early stages of
development. However, these require extra machining to fit our
application and we noted no significant changes when shifting
to the 3D printed equivalent. If selected, the lower drive wheel
[21T5/16-2, RS PRO] needs a spacer for the drive shaft in the
form of a L21x∅in5x∅out6 mm brass sleeve, and the upper rotor
wheel [21T5/32-2, RS PRO] needs machining work, as described
by figure S2 in the supplementary material.

Lastly, we manage to build the rotation mount described
here for approximately €150, using the components specified
in the appendix and assuming access to a 3D printer and basic
tools. Note that the price for some parts might increase due to
minimum order quantity requirements for some suppliers. As
an example, we show the components needed for a transmissive
mount in figure S1.

Build Guide

The assembly of a rotation mount starts by fitting the four M6 x
16 mm screws and nuts to the base mount (the frame), these are
used to clamp it to the mounting posts. After this, the stepper
motor is inserted and secured through the front with four M3 x 8
mm screws. Now, depending on the configuration the following
procedure will differ. For the reflective mount, a rotor base plate
is mounted directly to the drive shaft of the stepper motor with
an M3 x 6 mm set screw and nut. To this, an optic element holder
is attached by a clockwise quarter rotation of the pretensioning
fork (different rotors/holders are available). The optical element
is clamped down from the top by an M4 x 6 mm set screw and
nut. The position of its front face can be adjusted to align it with
the rotation axis and this is done with an M4 x 25 mm screw and
nut. Two additional nuts are used to lock the screw and remove
the slack (a spring can be used instead).

For the transmissive mount, the drive wheel is mounted to
the stepper motor with an M3 x 6 mm set screw and nut. The
drive belt then transfers this rotation to the rotor wheel and
this is mounted to the cage rotation mount [CRM1/M, Thorlabs]
with four No.4 x 6 mm screws. With the drive belt wrapped
around both wheels, the cage rotation mount can be secured
from the sides by four more No.4 x 6 mm screws. This should be
done to give the drive belt suitable tension and a good starting
point is at 4 mm belt movement when applying 0.5 kg of force,
as discovered while measuring backlash in section 3.B below.
Lastly, with all the parts and tools at hand, the construction and
incorporation of this rotation mount into an optical system can
be done within a day and that includes the building of a control
unit (driver), as described next.

B. Building the Controller
Components & Wiring

To control the rotation mounts we designed a controller based
on a standard Arduino board [11] and a SilentStepStick stepper
motor driver [TMC2130, TRINAMIC]. There are many Arduino
board models suitable for this controller, and here we show the
two most common models that can be used. The first is the
Arduino Nano, its small size and PCB compatible headers are
perfect for permanent installations and enclosures. The second
is the Arduino Uno, its larger size and accessibility is handy for
bench testing and experimentation. However, both of these have
similar performance and wiring.

The control unit can be powered by a 9 − 12 VDC power
adapter and to stabilize the supply, a 100 µF (C1) electrolytic ca-
pacitor is connected between the supply rail and ground (GND).
The supply rail is connected to the raw input of the Arduino
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Fig. 2. The minimum electronics and wiring needed to run a rotation mount when using the MWE code. This setup uses an Arduino
Nano microcontroller, a TMC2130 stepper driver and a NEMA 17 stepper motor, all mounted to a half size solderless breadboard.

(VIN) and the motor input of the driver (VM). The regulated
output from the Arduino (5V) is connected to the logical input
of the driver (VIO) and a Schottky diode (D1) is connected back
to the supply rail, with the cathode at the supply rail (allowing
for a safe connection of USB before power supply).

In addition, a switch (S1) or a jumper can be used to toggle
the auto-reset mode of the microcontroller on/off (used for up-
loading code), where a closed connection turns the mode off
(this allows the controller to remain running during the loss of
USB connection). On some Arduino boards (e.g. Nano V3.0),
this can be realized by wiring the switch in series with a 120 Ω
resistor (R1) and connecting them between the reset pin of the
Arduino (RST) and the regulated output (5V). However, on other
Arduino boards (e.g. Uno R3) there are two solder pads (RESET
EN) that can be cut and connected to a switch with the same
function.

The rest of the connections are described in figure 2, along
with all the electrical components (see appendix A) and wiring
needed to control a rotation mount. Note that the wire colors of
the stepper motor (M1) may vary between manufacturers and
that each coil can be found with a basic continuity measurement.
We show the wiring for a bi-polar (4 wires) stepper motor, but a
uni-polar (6 wires) stepper motor can also be used by connecting
the center tap of each of the two coils together. Additionally, the
stepper motor driver can be fitted with a small heat flange on
top to increase system stability and these are often provided by
the manufacturer.

Programming

The controller needs to be programmed before it can be used
to control a rotation mount and, for this, we provide a Min-
imal Working Example (MWE) code called RotorMountCon-
troller_MWE. With this code, the angle of a rotation mount
can be controlled from a computer and with floating-point pre-
cision. A more comprehensive code, called RotorMountCon-
troller_Multiple is also provided and both of these are available
in the resources [12]. The latter shows how to control four dif-

ferent rotation mounts (and drivers) simultaneously using one
Arduino Nano/Uno, as well as how to incorporate software
emulated origins, backlash compensation, intensity control, and
more.

To compile and upload code to the board, we used the open-
source Arduino IDE (V.1.8.12). This requires some additional
(open-source) libraries to be downloaded and these are described
in the code. When proceeding, remember to select the correct
rotor resolution, gear ratio, and step size (microsteps), these are
defined in the code. However, in case of problems to compile the
code or download libraries, pre-compiled binary files (.ino.hex)
of the MWE code can be found in the resources [12] for both
Arduino boards and rotation mounts (for a rotor resolution of
200 f ullsteps/revolution and a step size of 128 microsteps). The
procedure for uploading a binary file in Windows is described
in detail under section 7.B.

The USB interface of the controller can be accessed directly
by the serial monitor in Arduino’s IDE or ones like RealTerm. It
can also be integrated into larger automation software, such as
LabVIEW, because of its command-based interface. The interface
for the MWE consists of two functions, one for setting the rotor
angle ("SRA_<DEGREES>") and one for getting the rotor angle
("GRA"→DEGREES) from the mount. A help function ("HELP")
is also included to aid the operator while testing. When using a
serial monitor to talk with the controller, it is important to have
chosen the correct Baud rate (57600) and EoL character (CR+LF)
for the current system.

3. TEST AND COMPARISON

A. Measuring Setup
Before we can compare our 3D printed rotation mounts to com-
mercially available systems, we need to measure and evaluate
their most relevant attributes. To perform these tests, the MWE
code is modified by adding single-stepping capabilities and a
simple setup is constructed. This setup is used for both the
reflective and transmissive mount and can be seen under test



Manuscript 4

Fig. 3. The setup used to test 3D printed rotation mounts, here
seen with the reflective mount (RM). A laser beam is reflected
by the rotating mirror (M) and its position is measured by the
PSD. The remaining light is reflected to a beam dump (BD) and
absorbed.

conditions in figure 3, except now with ambient light present.
The rotation mounts are positioned to rotate in the plane of the
table, i.e. with the axis of rotation oriented vertically. Each
mount is fitted with a 1" flat mirror [5101-VIS, New Focus, Inc.],
mounted with its reflective surface along this axis. The rotation
of the mounts can then be determined from trigonometry by
reflecting a laser beam and measuring its position.

For this, a HeNe-laser (633 nm, 7 mW) [1137/P, JDS Uniphase]
is used and it is reflected towards a 20x20 mm position sensitive de-
tector (PSD) [2L20_SU9, SiTek]. This is mounted a given distance
D after the rotating mirror, which limits the measurement range
of the flat detector plane to ±15 mrad (2◦). The stage rotation
is calculated by ω = 0.5 · arctan(d/D), where the spot distance
d on the detector is calibrated from the PSD signal and for one
fullstep. The signal is collected with a computer, using a data ac-
quisition unit (DAQ) [BNC-2090, National Instruments]. To avoid
aliasing, a low-pass filter [SR640, Stanford Research Systems
Inc.] is used with a cutoff frequency of 4 kHz, while sampling
just above the Nyquist frequency (8192 Hz). Data is processed
from the DAQ in a custom LabVIEW program [2018_V.18.0f2,
National Instruments], see figure S4, and further analyzed in
MATLAB® [R2020a, MathWorks]. To aid in measurement accu-
racy, the setup is built upon a Nexus® vibration isolated optical
table [T1020CK, Thorlabs] and situated in a temperature con-
trolled room (296± 1 K).

B. Evaluation Criteria

We evaluate the reflective and transmissive mount separately,
because of their difference in construction. The results are then
compared to manufacturer specifications for commercial mounts
with clear apertures of ∅20− 40 mm, see table 1 in the appendix.

Velocity

The rotation of these stages is made in discrete steps, since we
are using stepper motors, and the size of these steps can be
reduced by dividing them into microsteps. A maximum step rate
of 4, 000 microsteps/s is allowed by the controller when using
an Arduino Nano/Uno (clock-rate limited). This is equivalent

to 6.4s/rev and 12.8s/rev, for the reflective and transmissive
mount, respectively and at a resolution of 128 microsteps. If
greater velocities are required, the resolution can be lowered by
using fewer microsteps. The maximum velocity for our setups
is reliably achieved at a resolution of 8 microsteps, to 0.4s/rev
and 0.8s/rev, respectively. This is limited by the strength of
our stepper motor but is still higher than that reported for most
commercial systems.

Resolution

The minimum incremental motion, here denoted (angular) reso-
lution, is a property dependent on both the stepper motor, the
transmission and the controller. It is defined as the change in
steady-state angle between consecutive steps and this is to disre-
gard intermediate overshoots, as seen in figure S5a. We start by
investigating the reflective mount with its direct transmission
(1:1). Since we always use the same stepper motor, the step size
of the driver becomes decisive for the final resolution, and this
driver can divide each fullstep into a much as 256 microsteps.

Looking at the median resolution for each step size in figure
4a, it can be assumed that the experimental data is in good ac-
cordance with the theoretical design resolution and this would
give a "typical" resolution of 110± 60 µrad at 256 microsteps for
the reflective mount. However, we would argue that the maxi-
mum value for each set would constitute a better estimate for its
nominal resolution. On this basis and while taking into account
the decline in stepper motor torque (and hence acceleration) for
smaller step sizes, a value of 128 microsteps seems to give an
adequate step size and a "guaranteed" resolution of 310 µrad.

Now, looking at the transmissive mount with its belt trans-
mission (2:1) in figure 4b. A "typical" resolution of 70± 30 µrad
is achieved at 256 microsteps, but the departure from the design
resolution has become more apparent. It shows an increasing
number of outliers at smaller step sizes and these are caused
by the delay and (non-returning) overshoot of steps, so-called
stick-slip behavior. These can be seen in the raw step response
data in figure S5b and are a result of static friction in the cage
rotation mount [CRM1/M, Thorlabs] and play (clearance) in the
belt transmission. Consequently, this will reduce the "guaran-
teed" resolution and a value of 310 µrad is again observed at
128 microsteps.

The maximum resolution is on par with many (but not all)
commercial stages and this is a compromise done to lower cost
and ease manufacturing. With that said, for many applications,
this resolution is more than adequate. For example, in an optical
attenuator setup, the transmitted intensity I is given by Malus’s
law [13] as

I = I0 · cos2 θi ,

where I0 is the input intensity (or irradiance) of the light and θi is
the angle between the light’s polarization and the fast axis of the
polarizing element. Its derivative describes the final resolution
in intensity for the setup and can be written as I′ = −I0 sin 2θ,
which decreases at low intensities (θi → π/2 rad). Thus, the
resolution is much better (I′ → 0) at low intensities, where it
is often needed the most, compared to in the middle. Even so,
a "guaranteed" resolution of 0.03 percentage points intensity
is achieved in the middle for both rotation mounts and this is
usually more than enough.

Accuracy

The uni-directional repeatability is commonly used as a measure
for accuracy and it shows how close to a reference position it
will come while returning from the same direction and a suitable
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Fig. 4. Minimum incremental motion at different step sizes for the reflective mount (a) and transmissive mount (b), calculated from
the step response data in figure S5. A stepper motor with 200 f ullsteps/revolution (1.8◦) resolution is used and we measure over a
stage rotation of 1− 2◦, resulting in different sample sizes (n) for each set.

distance away. Here we measured this by rotating the stages
in increments of full revolutions (2π rad) and finding the max-
imum deviation between these. This results in an accuracy of
250 µrad and 600 µrad, for the reflective and transmissive mount,
respectively and at 128 microsteps resolution. An accuracy that
falls within that of most commercial mount. Moreover, the ab-
solute position is not defined when using an open-loop system
like a stepper motor. So to aid in repeatability, a homing switch
is usually incorporated into the setup. For the sake of simplicity,
we instead show how to implement SW emulated origins in the
program of the controller.

Backlash

The backlash, also called bi-directional repeatability or hystere-
sis, is a measure of the total accumulated play in a system and is
noticeable as an angular loss when altering rotational direction
[14]. For the reflective mount (direct drive), there is no signifi-
cant mechanical play in the system but rather the backlash is a
product of the stepper motor torque and bearing friction. For the
transmissive mount (belt drive), the backlash is dominated by
the transmission and is a product of the belt tension. Removing
slack in the belt by increasing its tension will generally decrease
the backlash. However, if the belt tension is too high, excess fric-
tion in the cage rotation mount [CRM1/M, Thorlabs] will arise,
resisting the torque of the stepper motor and instead contribute
to an increase in backlash.

A compromise between these must therefore be found and
for our mount, this is at 4 mm movement when applying 0.5 kg
of (normal) force to the belt, midway between the wheels. This
results in a backlash of 700 µrad and 7000 µrad, for the reflec-
tive and transmissive mount, respectively and at 128 microsteps
resolution. Additionally, an alternative technique for backlash
reduction can be implemented in software and this is shown
in RotorMountController_Multiple. With this compensation
algorithm tuned for the transmissive mount, the backlash can
be reduced by a factor of 10 or more and this results in backlash
smaller than that for most commercial mounts.

Axis Wobble

Changes in tilt of the rotation axis during stage movements
are called axis wobble. We estimate this with the same setup

as before, however, we now measured the departure from the
horizontal axis. This is done by sampling the vertical position of
the spot on the PSD. The results, seen in figure S6, show the axis
wobble for a stage rotation of 2◦. The 95% confidence bounds
give an axis wobble of ±52 µrad and ±35 µrad, for the reflective
and transmissive mount, respectively. This is less wobble than
that for most commercial mounts and as expected, the plain
bearing in the cage rotation mount (transmissive) gives smoother
operation than the ball bearing in the stepper motor (reflective).
Note that these measurements were only done for a limited
range and are dependent on the quality of the components used.

Stability

Angular stability is crucial for the reflective mount to not in-
troduce disturbances into the optical system. We estimated the
stability by measuring the angle of a stationary rotation mount
for long periods of time and using Allan deviation calculations
[15, 16]. The result is presented in figure S7 and it shows that
there is no increase in fluctuations when turning on the stepper
motor power as opposed to when it is turned off. The predomi-
nant deviations are observed at the highest frequencies (1 kHz)
and are most likely originating in electrical interference of the
measurement equipment. Still, the angular fluctuations of the
mount are in both cases negligible and in orders of magnitude
smaller than the resolution, at less than 2 µrad. Moreover, the
low stepper noise of this setup is important while performing
sensitive measurements, and this would not be possible using
the piezoelectric rotor from previous works. This capability is in-
troduced by StealthChop™ technology, found in newer stepper
motor drivers.

4. EXAMPLE APPLICATION

As a proof of concept, we show how a rotation mount can be
used to control the output power of multiple lasers used for op-
tical tweezers and Raman spectroscopy measurements [17, 18].
To fill the back aperture of our microscope objective and to get a
strong lateral optical trap, we need an attenuator that can handle
a beam diameter up to 20 mm. A detailed description of the
system is shown in [19] and the attenuator setup is seen in figure
5. An earlier iteration of the transmissive mount is used to rotate
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Fig. 5. The optical attenuator setup uses a transmissive mount
(TM) to rotate a retarder (λ/2) and change the polarization di-
rection, thus controlling the output power of the laser. This
shows an application for the rotation mount, using it to remotely
control parameters in an optical system. (a) Multiple attenuator
setups each using a TM and one is mounted upside down to
allow for a lower beam path. (b) A schematic representation of
the optical attenuator setup. The dashed (blue) and solid (red)
lines represents the linear polarization components of the laser
light, propagating from right to left. The first gets reflected by
the polarizing beam splitter (PBS) and absorbed by the beam dump
(BD), while the second gets transmitted towards the optical fiber.

a retarder (λ/2) at the exit of each laser. In conjunction with a po-
larizing beam splitter (PBS), this allows for attenuation of the laser
output before coupling it towards the optical tweezers setup
(via optical fibers). This gives us control of the trap stiffness and
composition without affecting the enclosed system’s stability
(thermal/mechanical). The transmissive mount is suitable for
in-line optical elements and can be further developed for other
applications, like spatial filtering (aperture control), etc. The
reflective mount came about with the intent to allow for the
construction of spectrometers and other scanning applications.
However, it can also be used as a beam selector, filter revolver
or other application requiring stable and silent rotation [20].

5. CONCLUSION

We show an easy way of constructing rotation mounts using
tools and equipment available in most labs. By keeping the de-
sign simple and instead implementing functions in the program
of the control unit, we have reduced the number of components,
the price and the build time considerably in comparison to pre-
vious works. A rotation mount and driver can be built within
a day for no more than €200. Still, their performance is suffi-
cient enough for most applications and on par with commercial
systems costing more than €2000.

We provide component lists, build instructions and example
codes for two types of rotation mounts. We also provide open-
source 3D models for the manufacturing and further modifica-
tions of the system. A comprehensive list of commercial stages
and their specifications are given in table 1, to aid researchers in
need of a motorized rotation mount.

6. ADDITIONAL INFORMATION

Funding
This project is financially supported by the Swedish Foundation
for Strategic Research and the Swedish Research Council (2019-
04016).

Disclosures
The authors declare no conflicts of interest.

7. APPENDIX

A. Off-the-shelf Component List
Transmissive Mount:

• 1 pc - NEMA 17 Stepper Motor [17H2A4413, MotionKing]

• 1 pc - Drive Belt [10/T5/245SS, Contitech] (see figure S3)

• 1 pc - Cage Rotation Mount [CRM1/M, Thorlabs]

• 2 pcs - ∅12 x 150 mm Optical Post [TR150/M-JP, Thorlabs]

• 4 pcs - M6 x 16 mm Socket Screw [HK76168, Holo-Krome]

• 4 pcs - M6 Hex Nut [189-591, RS PRO]

• 8 pcs - No.4 x 6 mm Socket Screw [HK72018, Holo-Krome]

• 4 pcs - M3 x 8 mm Socket Screw [HK76012, Holo-Krome]

• 1 pc - M3 x 6 mm Set Screw [529-911, RS PRO]

• 1 pc - M3 Hex Nut [189-563, RS PRO]

Reflective Mount:

• 1 pc - NEMA 17 Stepper Motor [17H2A4413, MotionKing]

• 4 pcs - ∅12 x 50 mm Optical Post [TR50/M-JP, Thorlabs]

• 4 pcs - M6 x 16 mm Socket Screw [HK76168, Holo-Krome]

• 4 pcs - M6 Hex Nut [189-591, RS PRO]

• 1 pc - M4 x 25 mm Socket Screw [HK76080, Holo-Krome]

• 1 pc - M4 x 6 mm Set Screw [529-949, RS PRO]

• 4 pcs - M4 Hex Nut [527-252, RS PRO]

• 4 pcs - M3 x 8 mm Socket Screw [HK76012, Holo-Krome]

• 1 pc - M3 x 6 mm Set Screw [529-911, RS PRO]

• 1 pc - M3 Hex Nut [189-563, RS PRO]

Control Unit:

• Microcontroller Board [Nano V3.0 or Uno R3, Arduino]

• SilentStepStick Driver Board [TMC2130, TRINAMIC]

• 12 VDC Power Adapter [GST36E12-P1J, MEAN WELL]

• 100 µF Electrolytic Capacitor [ECA1CM101, Panasonic]

• Schottky Diode [1N5402RLG, ON Semiconductor]

• 2.1 x 5.5 mm Barrel Jack [RND 205-00905, RND Connect]

• Slide Switch (SPST) [MFS 131 D, KNITTER-SWITCH]

• 120 Ω Axial Resistor [174-2788, RS PRO]

• Add’l: Breadboard, jumper cables, enclosure, USB-cable.
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B. Upload Compiled Binary File with Arduino IDE (V.1.8.12) in
Windows (7/8/10)

1. Connect the Arduino board to a computer via USB.

2. Start the Arduino IDE and open the Blink sketch
(File→Example→1.Basic).

3. Choose the correct board type and serial port
(Tools→Board/Port).

4. Turn on output during uploading (File→Preferences
→Settings→Show verbose output during: upload)

5. Upload the sketch (Sketch→Upload).

6. In the output panel of the IDE, find and copy the AVR-Dude
call, i.e. the first line after the ”Global variables use...” line.

7. Paste this command into any text editor and replace the
rightmost file path (C:\Users\...\arduino_build_XXXXXX/
Blink.ino.hex:i) with the absolute file path to the new binary
file (C:\Users\.../RotorMountController_MWE.ino.hex).

8. For Windows 8 or never: Put all three (3) file paths in-
side of quotation marks (-CC:\Users\.../avrdude.conf⇒
-C"C:\Users\.../avrdude.conf", etc.)

9. Open the Command Prompt (Ctrl+Esc→"cmd"), then paste
and run the modified command.
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